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+421 901 123 456 

BRATISLAVA 

 

 
                                                     PREDSTAVENIE PRODUKTU 

Vážený zákazník, 

nasledujúce stránky popisujú produkt spoločnosti SQL Metrics, ktorý slúži na uľahčenie práce  

s databázovými systémami spoločnosti Oracle®. 

 

AWR Analyzer je dodávaný ako rozšírenie nástroja SQL Developer od spoločnosti Oracle®. 

 

Umožňuje rýchlu analýzu a detekciu problémov pri práci so SQL prehľadnou cestou  

vo forme GUI bez nutnosti inštalácie databázových procedúr, spúšťačov alebo funkcií a je 

ihneď po inštalácii plne funkčný.  

 

Rozšírenie má aj zaintegrovanú základnú funkcionalitu SPM (SQL PLAN MANAGEMENT).  

 

Analytický nástroj AWR Analyzer bol vyvíjaný pre databázy od verzie 11.2 pre štandard 

a Enterprise edície (AWR alebo STATSPACK). 

 

 

S pozdravom, 

tím SQL Metrics 
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POŽIADAVKY NA INŠTALÁCIU 

 

Minimálne požiadavky na inštaláciu rozšírenia AWR Analyzer sú: 

• Operačný systém: Mac OS®, Windows® a Linux® pre program SQL Developer distribuovaný spoločnosťou Oracle 

• SQL Developer: verzia 19.2.* a vyššia 

 

 

 

 

Poznámka: Rozšírenie nerieši licencovanie spoločnosťou Oracle pre prácu s AWR (Automatic Workload Repository). 

Pre používanie služby AWR je nutné vlastniť licenciu na používanie Oracle Diagnostic Pack v Databáze. 

Presné náklady na licenciu AWR nájdete v oficiálnom cenníku spoločnosti Oracle (PDF) alebo u Vášho distribútora. 

 

 
 

Služba STATSPACK bola predchodcom AWR. 

V riešeniach používajúcich Standard Edition (SE) alebo 12c Standard Edition 2 (SE2) poskytuje STATSPACK 95% údajov, ktoré možno nájsť v AWR, a je 100% 

bezplatné na inštaláciu a používanie. 

 

AWR Analyzer pracuje s Oracle RAC aj nie-RAC systémami od verzie 11.2. 

 

Pre správnu funkcionalitu rozšírenia musí byť nainštalovaný balík STATSPACK, respektíve AWR ako aj pridelené User Rights objektov pod daným užívateľom.  

 

 

*je možné dodanie rozšírenia aj pre staršie verzie. Je nutná osobná konzultácia a minimálna objednávka je 20 licencií 

  

http://www.oracle.com/corporate/pricing/technology-price-list.pdf
http://www.oracle.com/corporate/pricing/technology-price-list.pdf
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ÚVOD 

 

 

Štandartný STATSPACK/AWR analyzer poskytovaný spoločnosťou Oracle ako súčasť databázy je nutné spúšťať ako skript, poskytuje výstup v textovej forme, ktorá 

má zníženú čitateľnosť, orezané sql texty, nie je možný priamy náhľad na SQL plán bez nutnosti vytvorenia nového výstupu. Výstup je rozdelený na viaceré sekcie 

a pri hľadaní spojitostí medzi údajmi je nutné neustále sa pohybovať medzi jednotlivými sekciami.  

 

Príklad výstupu štandartného AWR analyzera po zadaní príkazov: 

Pre AWR:  

SQL> @$ORACLE_HOME/rdbms/admin/awrrpt.sql 

 

Pre STATSPACK: 

SQL>  @?/rdbms/admin/spreport 

 

    CPU                  CPU per             Elapsd                     Old 

  Time (s)   Executions  Exec (s)  %Total   Time (s)    Buffer Gets  Hash Value 

---------- ------------ ---------- ------ ---------- --------------- ---------- 

Module: DBMS_SCHEDULER 

MERGE /*+ dynamic_sampling(4) dynamic_sampling_est_cdn  */ INTO 

SYS.MON_MODS_ALL$ MM USING ( SELECT OBJ#, SUM(FLGS) FLGS FROM ( 

SELECT OBJ#, :B1 FLGS FROM ( SELECT DISTINCT TAB.OBJ# FROM (SELE 

CT T.OBJ# OBJ#, T.OBJ# BO#, T.ANALYZETIME FROM SYS.TAB$ T WHERE 

 

      9.40           72       0.13    3.5      10.94       2,992,477   62099832 

Module: DBMS_SCHEDULER 

INSERT INTO WRI$_HEATMAP_TOPN_DEP2 SELECT TABLE_NAME, OWNER, 'LO 

BS', SUM(SEGMENT_COUNT), SUM(OBJECT_SIZE) FROM DBA_LOBS, WRI$_HE 

ATMAP_TOPN_DEP1 WHERE WRI$_HEATMAP_TOPN_DEP1.OBJECT_NAME = DBA_L 

OBS.SEGMENT_NAME AND WRI$_HEATMAP_TOPN_DEP1.OBJECT_OWNER = DBA_L 

 

 

 

PREČO POUŽÍVAŤ AWR ANALYZER 

Rozšírenie Analyze AWR prezentuje údaje v prijateľnejšom GUI: 

• tabuľková forma dát 

• možnosť filtrovať údaje podľa SQL Module 

• integrované grafické zobrazenie % farbou 

• detaily SQL na jeden klik s možnosťou zobrazenia detailov na nove záložke v SQL Developeri pre vybrané SQL (funkcia dvojkliku) 

• zobrazenie SQL textu vo formátovanej podobe 

• plán vykonania SQL  

• ukladanie vybraných dát do pdf, excelu, clipboardu 

• možnosť definovať počet zobrazených údajov 

 

Navyše poskytuje údaje, nástroje, ktoré nie sú súčasťou originálneho AWR:  

• #Of Exec. Plans - počet rôznych execution plánov, ktoré používalo dané SQL 

• Binding Variables – logická hodnota true/false, ktorá nám ukazuje, či dané SQL má za behu uložené aj premenné s ktorými bežalo 

• SQL Plan Management - nástroj na ovládanie execution plánov (SPM funkcionalita je podrobne popísaná na oficiálnych stránkach spoločnosti Oracle) 

  

https://oracle-base.com/articles/11g/sql-plan-management-11gr1
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PRÍSTUP K AWR ANALYZER 

 

Rozšírenie AWR Analyzer je v SQL Developer pod položkou menu „View“ -> ”AWR and STATSPACK Monitoring Tools“ 
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UŽÍVATEĽSKÉ NASTAVENIA 

 

Rozšírenie umožňuje individuálne nastavenie: 

• farieb a počtu zobrazovaných riadkov v jednotlivých konzultáciách  

• jazykovej verzie 

 

 

PANEL NASTAVENÍ 

 

Prístup k nastaveniu farieb a počtu zobrazovaných riadkov v jednotlivých konzultáciách je v menu „Tools“ -> “Preferences“ 

 

 

 

Otvorí sa obrazovka, kde je možné upraviť: 

• požadovaný počet riadkov dát pre štatistické tabuľky  

• farbu párnych riadkov 

• farbu nepárnych riadkov 

• farbu percentuálneho grafického zobrazenia 
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JAZYKOVÉ VERZIE 

 

Výber jazyka konzultácii je riadený samotným SQL Developerom.  

Na webe sa nachádzajú viaceré návody, ako nastaviť jazyk. Použiť sa dá napríklad postup na nasledujúcom odkaze. 

 

Plugin  je štandardne dodávaný v jazykových verziách: 

• angličtina  

• španielčina, 

pričom ďalšie jazykové verzie môžu v budúcnosti pribúdať. Prípadne môžu byť dodané na vyžiadanie po predošlej dohode. 

  

http://sql.standout-dev.com/2018/04/howto-change-sql-developer-language/
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ANALYZE STATSPACK / ANALYZE AWR 

 

(Obrazovky sú takmer identické a rozdiely sú uvedené v samostatnej sekcii.) 

Prístup k nástrojom je: 

Analyze AWR je z menu „AWR and STATSPACK Monitoring Tools“ -> “Analyze AWR” 

Resp. 

Analyze STASPACK je z menu „AWR and STATSPACK Monitoring Tools“ -> “Analyze STATSPACK” 

 

 

Z menu sa zobrazí panel „Statspack Snapshots“, ktorý slúži na výber základných kritérii pre nasledujúce konzultácie: 

• časový interval pre sledované SQL udalosti (je možné vybrať viacero po sebe idúcich intervalov) 

• databázový server 

• databáza  

• „node” pod danou databázou.  

 

Výberové kritéria umožňujú výber z viacerých databáz ako aj nodov. 

Také prípady nastávajú ak sú do jednej databázy realizované importy STATSPACKU Napríklad z produkcie ktorá je umiestnená fyzicky na inom mieste kde si 

neprajeme priame prístupy do databáz z rôznych dôvodov. 

Rozšírenie AWR Analyzer tým teda umožňuje prácu aj nad importovanými dátami z externých zdrojov. 

 

 

 

VÝBER ČASOVÉHO OBDOBIA 

V prípade potreby je možné vybrať rôzne dni 
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Kliknutím na ikonku kalendára od a do sa sprístupnia dni na výber a umožní výber potrebného obdobia 

Zobrazia sa všetky snapshoty zvoleného obdobia zoskupené podľa dní a zoradené podľa intervalu od – do.  

 

VÝBER KONZULTÁCIÍ 

 

Pre zvolený snapshot sa uskutoční výber základných konzultácii pravým klikom myši. Zobrazí sa menu s dostupnými konzultáciami  

 

Analyze STATSPACK Analyze AWR 

• TOP SQLs 

• TOP Segments 

• TOP SQLs 

• TOP Segments 

• Top Evets 

  

 

 

 

 

Poznámka: Ak je potrebný širší výber snapshotov, (môžu byť v iných dnoch ), súčasným podržaním klávesy SHIFT a ľavého tlačidla myši a posunom myši sa 

zvýrazní celé obdobie. Pravým tlačidlom na myši sa zobraźi dostupné menu (TOP SQLs a TOP Segments)  

 

 

  



 

10 

 

TOP SQLS 

 

Konzultácia TOP SQLs zobrazuje v tabuľkovej forme dáta pre pre nasledujúce štatistiky: 

• SQL ordered by Elapsed Time 

• SQL ordered by CPU Time 

• SQL ordered by User I/O Wait Time 

• SQL ordered by Gets 

• SQL ordered by Reads 

• SQL ordered by Physical Reads (UnOptimized) 

• SQL ordered by Executions 

• SQL ordered by Parse Calls 

• SQL ordered by Sharable Memory 

• SQL ordered by Version Count 

• SQL ordered by Cluster Wait Time - dostupné iba pri RAC prostredí 

 

Panel TOP SQLs sa automaticky podľa počtu vybraných inštacií zobrazuje ako: 

• Single instance view – pre jednu vybranú ištanciu  

• RAC view - pri výbere viacerých inštancií 

  

 

SINGLE INSTANCE VIEW 
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RAC VIEW 

Panel TOP SQLs RAC view sa zobrazuje pri výbere viacerých nodov/inštancií. V porovnaní s predošlým náhľadom obsahuje štatistiky zo všetkých vybraných 

inštancií s prispôsobeným zobrazením. 

 

Poznámka: Táto funkcionalita je dostupná iba pri AWR Analyzer (nie pri STATSPACK). 

 

 
 

 

 

VÝBEROVÉ KRITÉRIA 

V hornej časti obrazovky sú prístupné výberové kritéria 

• Module  

• Rows per table - počet zobrazovaných riadkov na tabuľku 

a 

• Tlačidlo SAVE 

 

Kritérium Module – pri zadaní textu sa zobrazia iba SQL, ktoré majú splnenú podmienku: UPPER(SQL Module) LIKE UPPER(%‘zadaný text‘%) 
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Poznámka: Používanie tohto kritéria je veľmi výhodné pri optimalizácii procesov. Ak sa nastavuje názov daného batch alebo online procesu ako text do poľa SQL 

Module je umožnené identifikovať, ktoré SQL sú v daných procesoch. 

 

 

 

HLAVNÝ PANEL 

 

Hlavný panel zobrazuje všetky štatistiky v separátnych tabuľkách 
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UKLADANIE DÁT Z KONZULTÁCIÍ 

 

V ľavom hornom rohu je umiestnená ikona na exportovanie všetkých tabuliek do EXCEL dokumentu formátu .xlsx 

 

 

Názov súboru sa generuje automaticky, obsahuje identifikačné čísla intervalu snapshotov snap_from a snap_to (1 a 4). Názov súboru si užívateľ môže upraviť 

podla vlastnej potreby. 

 

Vygenerovaný EXCEL súbor má jednotlivé SQL štatistiky v samostatných záložkách viditeľných v spodnej časti. 
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KOPÍROVANIE DÁT DO SCHRÁNKY 

 

Obsah bunky, riadku alebo celej tabuľky je možné skopírovať do schránky po kliknutí na danú bunku, riadok alebo tabuľku pravým tlačidlom a zobrazí sa menu: 

• Copy Cell 

• Copy Row 

• Copy Table 

 

 

 

 

VIZUÁLNE PREPOJENIE TABULIEK 

 

Pri pohybe ukazovateľom myši cez tabuľky sa automaticky zvýrazňujú riadky s rovnakým SQL id v rôznych sekciách čo umožňuje väčšiu prehľadnosť. 
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DETAILY SQL 

 

Po kliknutí na zvolený riadok sa vpravo zobrazia detaily daného SQL. Tieto detaily sú podmienené používaným levelom STATSPACK / AWR. 

 

Detaily pozostávajú s nasledovných častí: 

• Panelová lišta 

• SQL text 

• Údaje pre každý plán vykonávania (PLAN_HASH_VALUE): 

o SPM panel - len pre Analyze AWR 

o execution plán 

o historická informácia 

o bind variables - premenné z runtime 

• Sumár za všetky execution plány 

 

 

PANELOVÁ LIŠTA 

 

Panelová lišta obsahuje ovládacie prvky k exportu a kopírovaniu dát detailov SQL: 

• Export všetkých detailov do dokumentu PDF 

• Copy - kopíruje SQL text do schránky 

• checkbox, ktorý určuje či sa má SQL formátovať, alebo zobraziť ako je uložené 

 

Ukážka exportov 

 

sqlDetails_a6ygk0r9

s5xuj_1_4.pdf
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SQL TEXT 

 

SQL Text zobrazuje text sql, a to buď formátovaný alebo v originálnej podobe v závislosti na vybranej voľbe „Format SQL“ v panelovej lište.  
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SPM NÁSTROJ 

 

V AWR Analyzer sú prístupné aj prvky na prácu s SPM. 

 

Stručne o SPM: 

 Výkon akejkoľvek databázovej aplikácie sa vo veľkej miere opiera o vykonanie dotazu. Zatiaľ čo Oracle optimalizátor je dokona le vhodný na vyhodnotenie 

najlepšieho možného plánu bez zásahu používateľa a plán vykonávania príkazu SQL sa môže neočakávane zmeniť  

z rôznych dôvodov vrátane: regulácie štatistík optimalizátora, zmeny parametrov optimalizátora alebo definícií schém a metadát. Neschopnosť zaručiť správny plán 

viedlo niektorých užívateľov zmraziť SQL plány alebo uzamknúť štatistiky optimalizátora.  

Avšak, tento prístup im bráni neskôr využívať výhody nových funkcií optimalizátora ktoré by zlepšili výkon SQL dotazov. Ideálnym riešením by bolo zachovávať 

aktuálny SQL plán počas zmien prostredia, pričom zmeny plánu by boli povolené len pokiaľ by priniesli zlepšenie výkonu . 

SPM poskytuje takýto rámec a umožňuje úplne riadený vývoj plánu príkazu SQL. Pomocou SPM optimalizátor automaticky riadi execution plány a zaisťuje, že sa 

používajú iba známe alebo overené plány. Keď sa nájde nový plán pre príkaz SQL, tento nebude používaný dovtedy, kým nebude overený databázou, či má 

porovnateľný alebo lepší výkon ako aktuálny plán. 

 

 

 
 

 

SPM funkcionalita 

 

Plány môžeme nahrať  z cursor cache 

 

 

 

 

alebo z workload repository 

  

 

 

 

Nastavenie plánu pomocou jedného kliku 
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Po nahratí plánu pribudnú ďalšie ovládacie a informačne prvky ktoré slúžia na zapínanie plánov a nastavení jeho parametrov. 

 

 

 

Plán je možné odstrániť kliknutím na tlačidlo drop this plan 

 

 

 

 

 

EXECUTION PLÁN 

 

V detailoch SQL sú zobrazené všetky execution plány podľa hash value v stromovej štruktúre aj s detailmi ceny (cost) za spracovanie.  

Vrchol stromu uvádza číslo PLAN_HASH_VALUE 
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BIND VARIABLES 

 

 

 

SUMÁRNE DÁTA SQL 
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TOP SEGMENTS 

 

Okno si zobrazíme právým klikom na list snapshotov a kliknutím na TOP Segments 

 

 
 

Hlavné okno TOP Segments 

 

 
 

 

Po vybratí riadku sa v pravom paneli zobrazí DDL daného objektu ako je tabuľka či index 

 

DDL je možné exportovať do PDF klikom na tlačidlo Save 

 

segmentDetails_SYS

-I_OBJ5-INDEX.pdf

exported_tables_2_

5.xlsx
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TOP EVENTS 

 

Hlavný panel s TOP Eventami v danom rozsahu snap od a snap do 

 

Poznámka: Top Events neobsahujú detaily SQL. 
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OPEN CURSORS 

 

Funkcionalita Open Cursors primárne slúži na zisťovanie príčin chyby „ORA-01000: maximum open cursors exceeded”. Táto chyba sa veľakrát rieši zväčšením 

parametra OPEN_CURSOR bez zisťovania reálnej príčiny, čo vedie k zvýšenej spotrebe systémových zdrojov. 

Hlavný zdroj tejto chyby častokrát spočíva v neuzatváraní kurzorov* ktoré sa už nepoužívajú (v JAVE a pod.). Pomocou funckionality OPEN CURSORS vieme 

detekovať sessions, ktoré majú najviac otvorených kurzorov. 

 

Open cursors sa nachádza v menu View-> AWR and STATSPACK Monitoring Tools -> Open Cursors 

 

 

 

HLAVNÝ PANEL 

Panel zobrazuje TOP Sessions podľa počtu otvorených kurzorov v grafickej forme na logaritmickej stupnici kde jednotlivé sessions sú farebne odlíšené a grafy 

obsahujú aj ich identifikáciu ako sú session id a číslo inštancie. Na grafe je umiestnená aj hodnota parametra OPEN_CURSOR ktorej dosiahnutie vyvolá chybovú 

hlášku ORA-01000. Pri výbere session o ktorej chceme zobraziť detaily bežiacich SQLs stači kliknúť na príslušné farebné tlačidlo.  
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VÝBEROVÉ KRITÉRIÁ 

Horná lišta obsahuje výberové kritériá na spojenie do danej databázy (V prípade monitorovania OPEN CURSORS ide o aktívny proces monitorovania v reálnom 

čase a tým pádom nie je funkčný na importovaných dátach z AWR- STATSPACKU) 

 

 

Výberové kritéria umožňujú prácu nad jedným (single instance alebo výber jednej pri RAC) alebo viacerými nodmi RAC databáz. 

 

V ľavom hornom rohu je na výber Cursor Select s možnosťou výberu z dvoch druhov 

 

 

Vpravo za výberom spojenia sa nachádzajú kritéria Refresh – určuje čas kedy sa obnoví obrazovka a doplní o aktuálne dáta. Na výber máme takisto počet 

monitorovaných SESSIONS a typ kurzoru. Je tu umiestnené aj tlačidlo na spustenie-zastavenie monitorovania. 

 

 

Položky Cursor Type(s) 

 

 

PANEL TOP SESSIONS 

Panel top session s tlačidlami a hlavnými údajmi 
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Po stlačení tlačidla sa v dolnej časti zobrazí zoznam všetkých SQL ktoré sú v danej session a môžeme ich exportovať alebo po dvojitom kliknutí sa zobrazí detail 

daného SQL (celé SQL sa zobrazuje ako tool tip ak ponecháme kurzor myši nad daným riadkom). 

 

 

 

Detail po dvojitom kliknutí 

 

 

Poznámka: Pri odhaľovaní problematických/neošetrených kurzorov je vhodné sledovať session, kde narastá počet open cursors a v detailoch  sa opakujú rovnaké 

SQL_ID. Taký stav ukazuje opätovné otvorenie kurzora s rovnakým SQL. Ideálne je spraviť export zoznamu sql v danej session, pretože takisto môže 

existovať  rovnaké SQL s rôznymi SQL_ID (v prípade tzv. Hard parse problem, kde sa neposielajú hodnoty ako premenné ale sú napevno v SQL). 
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FIND SQL 

 

Slúži na hľadanie SQL podľa rôznych kritérií (Modul, časť SQL textu, Plan hash value). 

Panel je primárne &určený na vyhľadávanie a je potrebné mať na zreteli že neselektívne vyhľadávacie kritéria môžu byť dlhotrvajúce.  

 

Panel Find SQL sa zobrazí po vybratí z menu View -> AWR and STATSPACK Monitoring Tools -> Find SQL 

 

 

Panel  okrem nájdených SQL zobrazuje aj ich základné informácie:   

• počet spracovaných riadkov 

• počet spustení  

• uplynutý čas  

• priemerný čas na jedno spustenie  

Po kliknutí na riadok sa zobrazia detaily SQL, ktoré môžeme sformátovať ako aj nahrať jeho plány cez SPM funkcionalitu (popísané vyššie). 
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PRÍLOHA 

 

PRÍKLADY RÔZNYCH EXECUTION PLÁNOV A AKO ICH INTERPRETOVAŤ 

 

V Execution Pláne sú uvedené všetky detaily jednotlivých krokov farebne zvýraznené a sú aj zvýraznené stĺpce ktoré boli použité v prípade RANGE SCAN. 

 

Príklad č.1 - v riadku INDEX RANGE SCAN má zvýraznený iba prvý stĺpec, čo znamená, že range scan použil iba prvý stĺpec v danom indexe. 

Táto vlastnosť nám pomáha rýchlo detekovať problémy s použitím nesprávneho indexu ako aj nesprávnej konštrukcie indexu. 

 

 

 

 

Príklad č.2 ukazuje koľko stĺpcov v danom indexe bolo ‚aktívnych’: 

 

 

 

Príklad č. 3 zobrazuje aké stĺpce boli použité pri SKIP SCAN 
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